
PRECON DAY

11:00 TRACK A 
Creating Surreal Composites in Photoshop  
with Julieanne Kost 

suzanne 
How do you blend images that have different exposures, colors, etc. the one 
you are using the images seem to be about the same pre-composite I try to 
photograph elements for my composites in flat light so that I can then add 
shadow and highlights to them. 
Adobe just introduced a Harmonize (beta) feature in the beta that will greatly help 
blend dissimilar images. 

Jay 
Would you use the harmonize tool to get the head to match the body? 
Yes, you can use the new Harmonize (beta) feature to help blend elements in a 
composite. It creates a new layer with the harmonized information so it’s not as 
flexible if you then want to reposition the individual elements, but you could always 
re-harmonize them after repositioning.

11:00 TRACK B 
Photoshop for Beginners with Erik Kuna 

JWLE 
Erik: a wonderful presentation. Can you clarify what you mean by “stamp it 
up” vs. “flatten image”. Ty.
Sure, flattening will merge all layers and discard what you did before that, 
whereas stamping up creates a flattened layer of all the layers below while  
keeping the others. 

JWLE 
Erik: where do you place your personal skies to make them available for Ps? 
I have them in a Skies folder in my Photos folder, but they can be anywhere. I like to 
keep them organized, though. 

JWLE 
Last question for an excellent lecture. After you did a generative expand, you 
made a selection that enhances the resolution (?) for the new area. Can you 
clarify? With appreciation, Eric 
When you do “generative” anything, it will give you a low-resolution preview. To 
match a higher resolution to the file, you have to (as of now) click that button next 
to it to increase the resolution. Hopefully, that will change in the future. 
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Cindy Jolly - North Carolina 
I don’t have a question, I just want to thank you for a fantastic presentation. 
You made it so clear and concise. I have been using Ps but I didn’t totally 
understand the layers and masking that well. Now I do. 
AWESOME, that was my goal. Once I REALLY understood layers and masks about 
15 years ago (after using it for at least 7 years before that), the world of Photoshop 
finally opened.

11:00 TRACK C 
Photoshop or Lightroom? Which One Should I Use? 
with Terry White 

Mette Klint 
Terry: Your portfolio collection sync the photos to your website, you press 
update, the photos will appear with the new edits you have done in LR - How 
do you do that in Adobe Portfolio? Thought you had to delete and upload new 
pictures, really annoying 
No need to delete. I just reset the album, and ANY changes I’ve made, including 
edits, are reflected. 

Ben 
Can you batch process dust removal in Photoshop by date when you realize 
there are dust spots on all photos from that date? 
You can batch process the images you select, and if you select the ones on a 
specific date, then yes. 

David from Dallas, TX 
If I import an image from LightroomCC to Photoshop as a smart object is 
it imported as a RAW file? If not what is the best option to use to keep it as 
close to RAW?
The image is always converted into an image that can be edited in Ps with the 
same quality/resolution, whether it’s a smart object or not. Raw files cannot be 
edited destructively. 

Vero James 
Is there a table that compares all the features and uses of the different  
Lightroom apps, Mobile, Desktop and Classic? 
Not that I’ve seen. 
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DAY ONE

11:00 TRACK A  
Safeguard Essential Lightroom Classic Files  
with Rob Sylvan 

Sandilou 
So, my understanding, if I had a Catalogue (in the previous example) like 
Catalogue 2-4.lrat, I can rename that in the “Rename Catalogue” function. 
Yes! So glad they added the functionality for renaming catalogs from within LrC. 
Makes it simple and straightforward. 

Sharon 
In what scenario would it be beneficial to use more than 1 catalogue? 
There are some folks who like to separate their professional work from their per-
sonal/family photos, so they might benefit from separate catalogs. Wedding/event 
photographers might keep catalogs for each client/event. Stuff like that. 

Marcy from Phoenix 
Rob, Great class! Is there a way to tell LrC to delete backups after say 4, or 
do you still have to go into the Catalog Settings window, Backups tab, and 
delete them manually? Thanks. 
No, it is still a manual process to manage the old copies over time. 

David F 
Hi Rob, To make sure my Catalog is not having issues, is it possible to get a 

“fresh start” with LrC that would include all your previous edits etc. 
I would just run the File > Optimize Catalog function, and let that run. If that works 
without a problem, then the catalog should be in good shape. 

Dianne_A 
Rob, I missed it on your screen. Do you check “Store presets with this cata-
log?” Why or why not? 
I don’t store presets with catalog. I like to keep them all in a central location shared 
with Camera Raw. 

June Norsworthy 
For Rob: When you have your external editor presets copied and you import 
them into another computer for using in LRC, don’t these Editor Presets (like 
On1 or Topaz, or Retouch4me have to be installed already on that computer 
you are copying them to? 
For external editors (basically other image editing programs), you just need to 
install that program on the other computer and that typically will create/install  
the plugins into LrC. 

Photoshop World 2025 Q&A

https://photoshopworld.com/account/#events


June Norsworthy 
I do like that you put files on a different location, such as the Dropbox on your 
local drive. However, I tried that and it filled up my HD, so what do you recom-
mend as a workaround? 
First, if your primary internal drive is short on space you want to safely and method-
ically create more free space by moving large files to another drive. Once you have 
more free space, I would keep copies of these essential files on another drive, like 
an external.

11:00 TRACK B  
Scott’s Favorite Photoshop Tips with Scott Kelby 

linkmarkr 
I’ve tried colorize and sometimes it just skips an area (like an arm)...Can I 
make it focus on one area to fix it? 
What you might try is to go ahead and colorize the image, then go back, select  
just the area it missed, press Command-J (on Mac, or Ctrl-J on Windows), to  
put just that area up on its own layer and then try running colorize again. It might  
do the trick. 

Craig Nowicke 
I met my wife of almost 44 years at my first paid gig August 1980. Glad to see 
you also met your wife from your early music days!
Thanks, Craig. Luckiest day of my life. :) 

Julie 
Hi, Scott. Is there any easy to way to remove dust from old photos or 
scanned photos? 
Hi, Julie. Unfortunately, in Photoshop, there’s only very slow, methodical ways, but 
did you see Terry’s Keynote? Now you can remove that stuff in about 12 seconds.:-)

11:00 TRACK C 
Camera to Cloud with Kristi Odom 

Stephanie 
Kristi, When you are editing on your phone what level of brightness do  
you have your phone screen set to? Thanks for a great class! 
I have it to 100% :-) Thank you for watching! 

Ps-User-Since-4Ever 
Is the Camera to Cloud feature available to DSLRs (such as the D850)? 
While Camera to Cloud is a feature in select mirrorless cameras, you can use  
SnapBridge to transfer files to your mobile. Thank you for joining today! 
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12:15 TRACK A  
Preset, Set, Go! The Power of Camera Raw  
with Moose Peterson 

Jay 
Moose, I went to get the settings for the Z9 and it is saying not found. 
Sorry you’re having issues, gotta search on Camera Settings (or click on Moose 
Camera Bag). Here’s the link https://www.moosepeterson.com/blog 
/mooses-camera-settings-2/ 

KarenOsh 
Moose do you have a list of raw defaults for the D850? 
I don’t have a list of the Raw Defaults, you’d need to head to the NikonUSA Website 
> Support > Instruction Manuals for that. 

Sam Knutson Photography 
Why do NR if you do Denoise? I thought they were the same so now I am 
guessing I don’t really understand what NR does. 
I do it because it produces the best file for me. Denoise is AI driven, Nr sliders is 
computer based. I prefer using both globally and targeted. 

Tori 
Moose: Always love your tutorials! I may have missed a bit of information at 
the beginning as to where to find the numbers for the Standard Picture Set 
for the first preset you taught in this tutorial. I have a Canon so that may be 
why I got confused. 
Thanks for the kind words. You’re not confused, it’s just all new. Canon doesn’t call 
it Picture Control and I forget what Canon calls it but you will find it and then, it’s 
basically the same. 

barb os 
Moose, where do we find the settings for other than Nikon? I missed what 
you said. 
I regret I don’t know where to find them. You will need to seek someone out with 
your brand of camera who have done a deep dive into this. Or, and it’s well within 
your wheelhouse, you come up with them yourself. 

June Norsworthy 
I need to be able to use presets I saved on a Photo in ACR, but I notice so 
many options, & so I have saved the selected presets, but then when I bring 
in the similar images- it does not paste them in, for similar photos, what is 
the best way to do this? 
I regret I don’t know where you are in the program or what exactly you’re trying  
to accomplish. My apologies, but can’t be of much assistance. Sorry. 
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June Norsworthy 
Hi Moose, On Firmware update on my Nikon z8, should I put the Firmware 
update on the CF Express card or on the SDXC card. Which will the Nikon z8 
be able to read?
You have a number of options. You can use either card, if the SD, just have the 
CFExpress card removed. You can do it via Snapbridge or direct connect with  
a computer. It’s no much easier now than it was just a couple years back.

12:15 TRACK B  
What’s New in Photoshop for Photographers?  
with Terry White 

June Norsworthy 
Hi Terry, you mentioned this: “You can buy a separate Firefly Plan”. How do 
I find out about this. I love it that you have included many of the AI engines 
out there like Gemini, like I saw on the Restoration photo you showed. 
Thanks, June 
You can check out plans here: https://firefly.adobe.com/ Click buy now to see the 
plan choices. 

Julie 
In the 9:30 session how did they get into firefly to restore old photos? 
Head to firefly.adobe.com/boards 

Ron P 
Terry, I found that if I crop a photo and then use remove sometime on the edge 
of the crop, it would try to replace. Does this new remove choices fix this?
Give it a try as you have a specific use case. 

Dana Pride 
When we use generative AI, does it use our “credits” or are we limited in how 
much we can use? 
It depends on which features you use. Some use credits, some don’t. See the 
breakdown here: https://helpx.adobe.com/creative-cloud/apps/generative-ai 
/generative-credits-faq.html

Edward 
Is it possible to mask the hat vs. shirt to only change the shirt color? 
Yes 

Ron P 
Does Harmonize use up our credits? 
Yes, it does. 
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Sherry Brooks 
Hi Terry - any idea when these Beta features will hit regular Photoshop? 
I can’t give you a specific date. Adobe MAX in October is a good time to watch  
and see. 

Marcy from Phoenix 
Terry - Great class! Phone app - Android too? 
Yes, Ps for Android is on the Play Store as a public beta. 

JonS
Does mobile = iPad too? for the dedicated Ps app? 
Depends on the context. There is an iPad Ps app, but the features differ. 

cat 
Why doesn’t Adobe put the dynamic text tool in InDesign 
Great feature request. 

12:15 TRACK C  
Out of the Studio, Into the Light: Classic Portraits 
on Location with Glyn Dewis 

David from Dallas, TX 
Can you give me some recommendations on the best way you found to carry 
all the lighting equipment (light stands, lights, modifiers etc...). 
To be honest, I don’t have that much kit when I do this. One light, a light stand, 
camera bag, and modifiers fit easily into a long roller bag, which fits into the car. 

Alan from Houston 
If the idea is to ‘match the scene’ with a flash, then is the whole idea of using 
a flash is to fill? Effectively balancing the existing light? 
It’s not ‘fill’ as I’m doing more than filling shadows to get detail; I’m lighting the 
entire subject adding highlight and shadow by the position of the light. 

David from Dallas, TX 
On light stands do you find yourself bringing lighter light stands for the obvi-
ous weight reduction making them easier to carry, or something heavier like 
a C stand that handle wind better? 
I prefer lighter, light stands and tend to use sandbags but filled with gravel…  
otherwise one of the group will hold the light stand as you saw in the video. 

NornG 
Glyn, do you use color correction on the flash when using out door flash? 
Only if there’s a definite light cast ... i.e., sunset. Then I would warm the light up.
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2:15 TRACK B  
Replacing Skies Like No One Would Know!  
with Ramtin Kazemi 

Diane from Sacramento 
Rammy, on sky replacements: Does it matter the angle you are shooting the 
sky? Should I be shooting out towards the horizon if I am using the sky for 
that type of shot? The clouds look different when shooting above our heads, 
different perspective. 
Good question. Yes, perspective matters. Even though you have room to play 
with, you do have to keep perspective into account. Especially when shot at 
ultra-wide angles. 

Jeff L 
Is there such a thing as harmonize when doing sky replacement? 
If you’re talking about the AI “Harmonize” tool, I prefer manual harmonization. 
Which is what the entire session was about. I much prefer to train our eyes to 
harmonize things manually. Otherwise, you can use the Sky Replacement Fore-
ground/Sky lighting adjustment in the initial Sky Replacement window

3:30 TRACK C  
Expand Your Photographic Horizons with  
Photoshop, Plug-ins, & Apps with Rick Sammon 

Cindy - North Carolina 
Rick, love your presentation. I love all the painting type effects. Where do  
you get the “Distressed FX App”? I just found that it is for IPhones and I have 
a Samsung S25. Do you know of something similar for painterly effects for 
Android phones? 
Thank you, Cindy!! Unfortunately, the Distressed FX app is only available for iOS 
devices. There is no official version of the app for Android. 

Leslie from CT 
Thanks Rick, lots of inspiration! Quick question..is there an app you recom-
mend for a watercolor effect? 
Thank you. Try Waterlog!
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4:45 TRACK A  
Compositing Without Compromise  
with Dennis Dunbar 

June Norsworthy 
Hi Dennis, What is a Color Check Layer? It is such a wonderful tool to apply, 
but I am not sure of how to make a color check layer, Thank you for the good 
explanation of Harmonize & esp. its current limitations in Ps Beta. 
June, Great question! The Color Check is actually 2 layers, one filled with 50% gray 
set to Luminosity Blending. The other is a Hue’Saturation Adjustment Layer we use 
to push the Saturation. This lets us see just the colors in the image. When I use this 
technique I put them in a Layer Group so it’s easy to toggle them on and off. 

Here is a link to a video that explains this idea very well: https://nemanjasekulic 
.com/one-of-the-best-color-matching-technique-in-Photoshop/

4:45 TRACK C 
Avian Stories: Exploring Birdlife Through the Lens 
with Deborah Sandidge 

Thank you! 
Where is this in Florida east coast? 
Yes, the flamingos were displaced during a hurricane and have made residence 
along the coastal areas of Indian River Lagoon, in the Allenhurst area. It’s well 
north, but considered part of Merritt Island NWR. This is accessible by boat. 
Launch point is Bairs Cove. 

Cindy - North Carolina 
Deborah, what a fantastic presentation. Your bird shots are so amazing.  
I am just starting to get into bird photography and enjoy it more than I 
thought I would. 
I’m honored, thank you! I’m glad you enjoyed it. Bird photography and videography  
is very rewarding! 

Don Bromberg 
When shooting birds, do you use Auto ISO? 
Great question. Sometimes in situations where the light varies, it’s easy to use 
Auto ISO. If the light isn’t wildly changing, I won’t need to use Auto ISO. It’s helpful  
in photography, but I don’t use it for videography. 
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Joe - St. Augustine 
Hi Deborah, Are you photographing the flamingos in Merritt Island NWR?  
If so what area are you finding them? 
Yes, but not on Black Point Drive. The flamingos are just north of that area on an 
island accessible by boat or kayak. You can launch at Bairs Cove off of Haulover 
Canal. There is a large population of manatees there in the cooler months. The 
island is informally called Bird Island, a protected island by FWC. Here is a link  
to an article on the flamingos in this area. https://www.orlandosentinel.com/2025 
/06/26/florida-flamingos-merritt-island/?share=lwd2atlmfnwltgmii5f2

Stephanie 
Deb, how do you decide when it’s best to shoot video vs photos? 
Great question! I will always find a way to make video work. I like light falling on the 
subject, so I arrange to be in the right place at the right time. Backlit videos can be 
stunning too. I generally will shoot both still and video any time I am out. 

Bill Mitchell 
Beautiful work, Deborah. Do you pan the camera or rely on a fast shutter 
speed (or both) to capture the images of birds in flight?
That’s a great question. If I am hand-holding the lens, I’ll pan with the birds. Often, 
I’ll notice the opportunity for birds in flight as I’m shooting stills, and I’ll switch 
over to video. I use the Wimberley gimbal for most of my panning shots or shoot 
handheld. The gear I use is at least 10 lbs, so it can be physically demanding. I 
recommend handholding, using a gimbal, or using a fluid head for limited panning. 
I also use a video fluid head for video, when I’m not in the water! Gimbals offer a 
tremendous amount of flexibility with stills and video. 

Wing 
Hi Deb. Does pre capture work alongside with auto capture on your Nikon? 
Yes, you should be able to set up your camera for Pre Capture and also Auto Capture.  
Auto Capture is one of the overlooked features; it’s basically a very sophisticated 
camera trap that works incredibly well for stills and video. 

TWAlumni 
Awesome class. Beautiful images. 
Thank you
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DAY TWO

11:00 TRACK A  
Camera Raw for Lightroom Users with Rob Sylvan 

Jennette 
Does it matter if it Photoshop or Photoshop Beta in preferences? 
If you are using Photoshop Beta you can set that to be the primary external editor 
in LrC, just be careful since it is beta software. Both Ps Beta and the release ver-
sion of Ps use the same ACR plugin, so nothing more to do there. You would want 
to set Ps Beta’s file handling preferences the same as I showed for this release 
version of Ps. 

Diane from Sacramento 
Rob regarding Camera Raw settings in Ps, I have the display color setting on 
P3 instead of the standard sRGB color space. Is that ok? 
You may not see any visible difference, but for editing purposes, I would stick to 
16-bit Prophoto in ACR (especially when going back and forth for editing in LrC). 

Janet 
Rob, How are you moving your image around without using your mouse while 
in the zoom window in camera raw? Is it a mac thing? I find the zoom window 
in raw very frustrating. This sure would make it easier! Thanks! 
Ah, I use a Magic Mouse, which is a Mac mouse that the top can function like a 
touchpad, so I can physically move the mouse and cursor or I can drag my finger  
on the top of the mouse to move the image around (instead of having to hold  
down the space bar, then click and drag with the mouse).

11:00 TRACK B  
10 Things Gen Fill Can Do That You Probably  
Haven’t Thought Of with Scott Kelby 

PhotoBob 
Scott With respect to removing the multiple areas of lens flare, to keep the max
imum resolution for each, would it be better to do smaller selection areas? 
Yes - if you’re removing a large area, it’s always best to do either smaller selec-
tions, or use the Enhance detail button to better match the overall resolution of  
the image.:-)

Dave G 
Does this Generative Fill use Adobe credits? 
It does, but it matters which plan you’re on, because you might have a whole bunch 
of credits, or an unlimited amount, or just a few per month. Check Adobe’s site for 
which plans offer what amount of credits. 
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Scubatwig 
Noticed it ‘generated similar’ from FireFly 3 - do you need to reset to FireFly1 
when this was the source or base image for generate similar? 
Yes, my bad on that. If you started with a FireFly 1 image, and you want to generate 
similar, make sure you’re still on Firefly 1. 

PhotoBob 
Other than clicking in the upper left hand corner of the thumbnail of the Gen 
Fill selection to increase the resolution, is there anything else that can be 
done to further increase the resolution of the selection ? 
Yes, just use smaller selections. Instead of one big one, do smaller ones instead, 
and that helps a lot, resolution-wise. 

Ron P 
Can you prompt like paint like a Degas? 
I dunno know – give it a try. I mean, you can use that as a prompt, but will it paint 
like a Degas, well, you’ll soon find out. LOL! :-) 

Dwight_in_Tennessee 
Scott, will you have a handout for the 10 Things Gen Fill Can do for you? 
I have something better – you have this course archived for an entire year, so 
you can come back and rewatch it anytime. A year from now, at the rate of speed 
Adobe’s Gen Fill is changing, that’s about it’s lifespan and it’ll probably be way 
outdated by then, but from now until then, you’re set. 

Bill Lindsay 
Great job Scott! You are AWESOME and I always learn something new! 
Thanks, Mr. Bill. :-) 

BethW 
Is there a cheat sheet best words to use for the Generative Fill field? 
There might be one out there, but I don’t know where. It’s a bit of trial and error  
for sure. 

Anna
What does “rasterize” do? 
It changes it from a Gen Fill layer into a regular standard layer. 

SueT 
Scott is the high res render still doing the fix at 1080x1080? 
Yeah, it’s still there (I thought it would have been higher by now - it’s been two 
years), so make sure you take advantage of the Enhance Detail feature, and if  
it’s a big area you need to have it fill, cut it up into smaller pieces. 
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Shannon in Texas 
Scott - When you use Generative Fill and click on enhance detail afterward, 
and it says the area is too small, does that mean you don’t need to worry 
about the resolution in that area? 
Well, that’s a fair question. I guess it feels like the area falls well within the 
1080x1080 resolution boundary – if it’s more than that, it lets you use enhance 
detail, but either way, we don’t really have a choice. It either lets us do it, or not, 
which is probably not what you wanted to hear. LOL! Sorry about that. 

11:00 TRACK C  
People Photography for the Landscape & Travel 
Photographer with Neil & Susan Silverman 

Jeff L 
Many of your beautiful images are desaturated. Is that an intentional style 
decision on your part? 
There are a few that are intentionally desaturated; today there seems to be so 
much super saturation that the “normal” may appear to be under-saturated.

12:15 TRACK B  
Master the Mask: Modern Techniques for  
Perfect Selections with Glyn Dewis 

TeaBerry 
Is Harmonize only in beta? 
Yeah it is at the moment. 

Alison 
When you regenerate (a second set) does it work from the original image or 
the generated version you are selected on? Great session, thanks. 
It works from the original image so starting afresh 

Bill Lindsay 
Thank you Glyn, GREAT job! (We need to get you a v2 version of our  
Pen Tablet! You wave the Pen around sooooo much, it’s AWESOME!)
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12:15 TRACK C 
Photographing from the Inside Out: Mood,  
Meaning & Your Inner Vision with Karen Hutton 

Tori 
Karen: Your classes always give me inspiration but this class was phenom-
enal! I love nature but have not been able to find my voice. Thank you so very 
much for sharing yourself and being so incredibly authentic! I’ll be listening 
to this class again! 
Thank you so much for taking the time to write this beautiful comment. It makes 
me so happy that these perspectives help. They are literally the way I do every-
thing, from Photography to life itself. It is always my fondest dream and hope that it, 
in some way, “brings it” for someone else. You’ve just confirmed it. Sending hugs!

2:15 TRACK B  
Photoshop On All Your Devices! with Terry White 

Alison Tuck 
In LRC all the slider settings persist. In Camera RAW after I say DONE and 
then reopen Camera RAW all the sliders are at zero. How can I get back to my 
previous slider settings in Ps? 
If you convert the layer to a smart object first, then you should be able to go back 
and edit your settings. 

Vero James 
I find having the different Lightroom applications confusing. Should I settle 
on one only? What’s the best use of each? 
Yes, you should pick one, and I have a KelbyOne class to help you decide. 
Lr or LrC, which one is for you? https://members.kelbyone.com/course/
terry-white-lightroom-or-lightroom-classic/ 

Gail K 
Terry, Is the remove people option available on the iPad and phone? 
It is on iPhone. Not on iPad yet. 

June Norsworthy 
How do I change my color space in Photoshop to ProPhoto to match LrC.  
I need to change to 16-bit Prophoto in ACR (especially when going back  
and forth for editing in LrC). 
You can change your Ps color settings from the Edit menu and choose ProPhoto. 
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4:45 TRACK A  
The Moment it Clicks: A Guide to Complete  
Photography with Joe McNally 

Ron P 
Joe, do you ever get a chance to shoot wildlife like Puffins ;-) 
I did :-) And I suck at it!!! 

DAY THREE

11:00 TRACK A  
Costa Rica Jewels: A Walk in the Rainforest  
with Moose Peterson 

Sharon B 
Moose, would love to know if you could supply a link or information on where 
you stayed in Costa Rica. Would love to see and hear all these birds in person.
The lodge is Rancho Naturalista https://ranchonaturalista.com/ 

Tori B Sanders 
Moose: Absolutely love your images of Costa Rica birds! Do you have any 
classes on Kelby on how to use flash on bird photography? Flash is definitely 
the one skill in repertoire that I am missing. Thank so much for sharing these 
beautiful images! 
Thanks for watching! Ah, I don’t think that I do. Perhaps we can do something 
about that :-) 

Leslie from CT 
Moose, at some point in my photographic journey, I was told not to use flash 
with bird photography as it tends to startle and scare them off. It seems like 
you don’t find this to be an issue, can you speak to this? 
Nothing really to speak of, you saw it for yourself, not an issue. 

Woostein 
Moose: did you use a particular guide or service on your Costa Rica trip to 
photograph the hummingbirds? Did you stay at Rancho Naturalista? I did not 
use a guide.
Yeppers, stayed at Rancho Naturalista. 
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11:00 TRACK B  
Color Adjustments with Photoshop’s Contextual 
Task Bar with Gilmar Smith 

PhotoBob 
How do you get the contextual taskbar to show? 
Go to the top menu and click Window → Contextual Task Bar. (Make sure it  
is checked)

11:00 TRACK C  
Studio Portraits That Don’t Look Boring  
with Mary Bel 

June Norsworthy 
Hi Mary Bel, I was watching your video at the end, and noticed that you are 
creating your own shadows and highlights by hand, dodging and burning, 
using portrait modes What equipment did you use to video your screen? and 
then speeded the Timelapse up? 
I used a desktop application called OBS to screen record my screen. It also records 
video and audio simultaneously. 

2:15 TRACK B  
Sky Replacement: The Three Mistakes People Make 
When Replacing the Sky with Serge Ramelli 

Theresa M. 
Serge, Is there a way to add new skies to Photoshop? 
Yes when you select a sky, you can click on the plus at the bottom right of the 
window and add as much sky as you want. 

Mette Klint 
Serge: What should you pay attention to when making your own collection  
of skies? Filetype? Naming? Camera settings? Library folder structure?  
And so on - Thanks in advance 
I would do a folder per moments of the day like Golden Hour, Sunset, blue Hour, 
Night Day light. 
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Dave G 
How important is it to use similar capture settings to create a library of skies, 
that may be used with an image? I often will shoot a sky with my phone when 
I see something I like. 
I would not do it with the phone as the quality will not be good enough to good with 
high end sensor, unless you should raw at at a low ISO. 

Alison and Jeremy 
Thanks Serge - a brilliant session!! 
Thanks for tuning in.

3:30 TRACK C  
Photoshop Anywhere: Producing Client Content  
on Mobile Devices with Lisa Carney 

Gail K 
Hi Lisa, which is best to export? PSD or Tiff? 
There is no best, honestly it is just what you need. Some clients need tiffs for their 
workflow. IF it is just staying with me I leave in native Photoshop format.

4:45 TRACK A  
Night Photography Editing Masterclass  
with Erik Kuna 

Larry Hugg 
For Erik K - what light sources do you use  for painting? 
Small LEDs, like Lume Cube minis, Luxli Fiddles (discontinued), Ulanzi LEDs. 

Tori B Sanders 
Erik: This is a terrific class! Wondering if there is a reason for not using  
the sharpening tool under Detail in Camera Raw. Are the images sharp 
enough so they don’t require sharpening? Or do night images not look  
great with sharpening? 
Ah, good question, usually sharpening a night image leads to the image looking 
fake, but you can do sharpening too, just want to be careful not to do too much. 
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deloperc 
Do you worry about the purple areas in the night sky? Not the areas  
in the core. 
It all matters on the image. If I feel it needs to be different, I adjust it. 

Alison Tuck 
Thanks Erik - A great course as always!! 
Thanks for tuning in. 😊 

June Norsworthy 
Hi Erik, I heard you say that you have a list of safe places to photograph at 
night. Looking for this!! Wonderful image 
Thanks, for you, go to Kissimmee Prairie Preserve State Park, rent an astronomy 
pad which will give you overnight access and have fun! About 2-3 hours from 
Tampa. Hardest thing will be finding clear skies in Florida but it’s possible. 

4:45 TRACK B  
Extraordinary Photoshop Effects to Take Your 
Workflow to the Next Level with Victoria White 

Gail K 
When I get around to modifying an image, I am trying to remember what to 
do. I search around for the specific details on Google, Youtube, KelbyOne, 
etc. Instead, is there a way to ask Ps AI for details on how to do a specific 
modification? 
Using Generative AI in Photoshop is all about the direction you give it. Your prompt 
is how you tell the AI what you want to change in your image. A more detailed 
prompt gives the AI clearer guidance. Try to include as many details as possible  
in your prompt.

4:45 TRACK C  
Multishot Magic: HDR, Timelapse & Panoramas  
with Colin Smith 

Ron P 
Can you do a sky replacement in a Pano, and what sesquence? 
Yes, you can do sky replacements in panos, it doesn’t always work as well because 
of resolution, so its often best to use your own sky photos that are higher resolution.
You would do this after merging and straightening. Do it right before color correc-
tion, because sky replacement will change the colors. 
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CCook 
Where do we go to get your free stuff mentioned at the end? 
https://photoshopcafe.com/vault 

June Norsworthy 
What was that link over at photocafe.com? 
https://photoshopcafe.com/vault

neil 
Colin, why less noise with the HDR than with the individual images. 
Because when you shoot the longest exposure, it lets more light in and provides 
a cleaner exposure. Also you are blending multiple images together which gives 
more picture and less noise. 
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